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BEFORE YOU BEGIN
Coherent product information is now available in one easily accessible 
location on the Coherent website. Filter your search by product type, 
document category, or both.

Downloads
Go to the Resources section on the Coherent website:

https://www.coherent.com/resources
• Software
• Drawing Files
• Quick Start Guides
• User Manuals
• Datasheets
• Application Notes

Products Supported
BeamView.NET supports the following cameras:
• LaserCam-HR, LaserCam-HR-II-1/2”, LaserCam-HR-II-2/3”
• LaserCam-HR-UV, LaserCam-HR-II-2/3”-UV
For information about sensor products, go to: 
https://www.coherent.com/laser-power-energy-measurement 
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INSTALLATION AND SET-UP
This Quick Start Guide provides an introduction to the BeamView.NET 
beam-analysis software and includes the following sections:
• Features of the software

• Products supported
• System requirements

• Installation instructions 
• Instructions to connect system components (camera and PC)

BEFORE YOU CALL SUPPORT: 
When installing the software, check whether your 
organization’s IT department has security 
policies or controls in place that may cause the 
software installation to be incomplete.

Features
BeamView.NET software offers the following features:
• Adjustable trigger delay assures a valid laser pulse is captured
• Additional calculations for flat-top beam analysis
• Remote mode interface and new commands
• Plug-and-play for camera set-up; support for multiple cameras
• Set variable aspect ratios for each camera
• Increase in the number of samples that can be captured; save 

images using industry-standard file format
7



BeamView.NET Quick Start Guide
• Camera information embedded into image files. Software is back-
wards compatible, to directly import images (.bin, .img, or .png), 
configuration files (.atc), and test files (.ats) generated by old Beam-
View software into the BeamView.NET

Products Supported
BeamView.NET supports the following cameras:
• LaserCam-HR, LaserCam-HR-II-1/2”, LaserCam-HR-II-2/3”
• LaserCam-HR-UV, LaserCam-HR-II-2/3”-UV

NOTE
The LaserCam-HR-InGaAs camera is currently not 
supported in BeamView.NET and should continue 
to use the BeamView v4.8.3 software.

For information about sensor products, go to: 
https://www.coherent.com/laser-power-energy-measurement 

Complete installation of the software before you connect any hardware.

IMPORTANT!
When a Low-Distortion Face Plate (LDFP) is 
installed in the camera unit, special safety 
precautions must be taken to avoid damage to the 
sensor. See “Safety Precautions for Cameras” on 
page 27 for more information.
8
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Software System Requirement
This section describes system requirements:
• Windows 10 (32- or 64-bit)
• 2.5 GHz processor or faster
• 2 GB of RAM or higher
• 5 GB of available hard disk space
• USB 2.0 or RS-232 port

Install the Software
1. To download the software and drivers necessary to install and 

operate the BeamView.NET software, go to the Coherent website.
https://www.coherent.com/resources

IMPORTANT
To avoid instability of the application, it is strongly 
recommended that you first disable computer 
hibernation or suspend mode before installing the 
software.

2. Save the installation files to your computer.

IMPORTANT
It is recommended that you use Administrator 
privileges to install and run software.
9
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BeamView.NET Quick Start Guide
3. Double-click to run the file, where x” is the latest version:
BeamView_5.0.1.x.exe

• If AutoRun is enabled on your laptop or computer, installation 
starts automatically.
If it does not start automatically, select Run from the Start menu 
and enter the location of the installation file on your computer.

4. Follow the on-screen instructions to complete installation, described 
in the steps that follow.

For any issues with software installation, see troubleshooting tips in the 
BeamView.NET User Manual. You can download that document from the 
Coherent website at:

https://www.coherent.com/resources

As the installation process begins, the first message that is displayed 
reminds you to first close all other applications.  

If other programs are running, stop the installation process now and 
close them.
10
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Accept License Agreement 
The License Agreement for BeamView.NET is displayed. Select the radio 
button to Accept the agreement, then click Next to proceed with the 
software installation. Otherwise, click Cancel to stop installation of the 
software.  

Select Destination Location
Review the directory listed in the “Browse” line. If acceptable, click Next. 
Otherwise, browse to select a different location, then click Next.  
11
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Select Start Menu Folder
Review the directory that is displayed. If acceptable, click Next, or 
browse to select a different location, then click Next.  
12
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Set Desktop Shortcut
This option allows you to create a desktop shortcut. Click the checkbox 
then click Next when done.  

Preview Set-Up
This screen lists the selections that you have made. If you want to 
change any settings, click Back. Otherwise, click Install.  
13
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A progress bar is displayed as installation proceeds.  

Because the software installation includes device drivers, another screen 
is displayed for explicit permission:  

Select whether to install or not, and complete installation.
14
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Complete Set-Up
When installation is complete, the final set-up screen is displayed. Select 
Yes or No to restart the computer, then click Finish.  

Launch BeamView.NET Software
Launch the BeamView.NET software. To do so, double-click the desktop 
shortcut icon that was placed on the desktop during installation.  

The splash screen is briefly displayed:  
15
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For more information, go to the Coherent website and download the 
BeamView.NET User Manual: https://www.coherent.com/resources

Connect Hardware
For detailed instructions about setting up hardware, see the User Manual 
for the appropriate camera, or check the HELP files or the 
BeamView.NET User Manual.

IMPORTANT!
Complete installation of the software
before you connect any hardware. Also read 
special safety precautions when using a camera 
that has a Low-Distortion Face Plate (LDFP) 
installed in the camera unit.
16
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After the BeamView.NET software is installed, connect the following:
1. To establish a connection with a PC, plug the USB cable into the 

camera and into the USB port on the PC. The LaserCam-HR 
cameras require only a standard USB cable (shipped with the 
camera) and a computer with a USB 2.0- compliant port.  

When the camera is to be used with an external trigger, connect a 
“Y” cable. Connect the camera end by rotating the cable until the 
orientation matches, and then pushing the connector securely onto 
the mating connector.  

This allows connection of an external trigger source through a BNC 
receptacle (plug-style connector). The other end connects a TTL-
level Pass/Fail output signal generated by BeamView from user-
configured calculation settings. 
17
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See the HELP files or the BeamView.NET User Manual for 
information about configuring software for an external trigger.

2. After you plug in the camera, wait a few seconds for the computer 
to recognize that hardware.

3. In the BeamView.NET software, click the Setup tab.
4. Click the Camera icon in the toolbar. A pop-up dialog box displays 

the model of camera connected:  

If you later connect multiple cameras, the dialog box displays a 
drop-down menu that lists all cameras connected.

5. Click Select to choose the camera you want to use. A User-Defined 
ID Number is displayed. Click OK.

IMPORTANT!
When a Low-Distortion Face Plate (LDFP) is 
installed in the camera unit, you must take special 
precautions to avoid damage to the sensor. See 
“Safety Precautions for Cameras” on page 27 for 
more information.
18
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BeamView.NET Interface
The set of tabs across the top of the BeamView.NET software application 
include the following windows.
• Home
• Edit
• View
• Capture
• Analysis
• Setup
• Help

The first screen that is displayed for the software is shown here.  
19
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For details about the functions and operations of commands in each 
window, see detail in the HELP files or the BeamView.NET User Manual. 
To download software or the User Manual, go to:

https://www.coherent.com/resources

Home Tab
The Home Tab lets you select the sample, start and stop capture, as well 
as whether to include crosshair, aperture, profiles or reference positions 
for the sample. You can also select the level of zoom and coloring style. 

Edit Tab
The Edit Tan lets you select the current sample displayed, copy the view 
plot or selected results to the clipboard, and clear the image data buffer.  
20
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View Tab
On the View Tab, you can select the level of zoom, display calculations, 
statistical results, and/or test results. Also, you can configure crosshair 
and various profile settings.  

Capture Tab
On the Capture tab, you can choose to show or delete the Collection 
Map, enable Continuous Wave (CW) or Pulsed capture operations, 
select trigger operations, the resolution and depth, as well as configure 
the storage buffer for samples. You can also specify the exposure time.  
21
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Analysis Tab
The Analysis tab provides commands to select analysis calculations, 
configure pass/fail options, configure overlay apertures, define reference 
coordinate positions, define inclusions areas, select system display units, 
and select averages.  

Setup Tab
The Setup Tab lets you adjust properties for the selected camera, define 
input power/energy for calibrations, set the input optical magnification 
scale, input far-field optical focal length, and set password protection for 
configuration settings.  
22
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Help Tab
The Help tab displays contents of the Help file, lists shortcuts, displays 
status for both system and background warning status, and license and 
copyright information for the software.  

After you connect a camera, notice that the Home tab now expands the 
content on the right side of the screen, shown next.  
23
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For more information …
For details about the functions and operations of commands in each 
window, see detail in the HELP files or the BeamView.NET User Manual. 
To download the User Manual, go to: 

https://www.coherent.com/resources
24
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Safety Information
This section provides an introduction to safety information, including 
signal words and symbols that you need to know before you begin taking 
measurements.

Signal Words and Symbols
This documentation may contain sections in which particular hazards are 
defined or special attention is drawn to particular conditions. These 
sections are indicated with signal words in accordance with ANSI Z-
535.6 and safety symbols (pictorial hazard alerts) in accordance with 
ANSI Z-535.3 and ISO 7010.

Signal Words
The following signal words are used in this documentation:  

Symbols
The following signal words are always emphasized with a safety symbol 
that indicates a special hazard, regardless of the hazard level. The icons 
are intended to alert the operator as described here:  

SIGNAL WORD DESCRIPTION

WARNING Indicates a hazardous situation that, if not avoided, 
could result in death or serious injury.

CAUTION Indicates a hazardous situation that, if not avoided, 
could result in minor or moderate injury.

NOTICE
Indicates information considered important, but not 
hazard-related. “NOTICE” may also be used when 
there is the risk of property damage. 
25
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Laser Safety
Laser light that is emitted may be in the infrared area of the 
electromagnetic spectrum and may not be visible to the human eye. 
Safety precautions listed here are to be read and followed by anyone 
working with or near a laser. 
At all times, ensure that all personnel are protected from accidental or 
unnecessary exposure to laser radiation.

WARNING! 
Direct eye contact with the output beam from a 
laser causes serious eye injury and possible 
blindness. Always avoid exposure to eye or skin 
from both DIRECT and SCATTERED radiation.

ICON TELLS THE OPERATOR ABOUT …

Important information or instructions for operation and 
maintenance. 

Danger of exposure to hazardous visible and invisible laser 
radiation.

Susceptible to Electro-Static Discharge (ESD).
26
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General Laser Safety Precautions 
Because of its optical qualities, laser light poses safety hazards not 
associated with light from conventional light sources. 
Avoid direct exposure to the laser light, and follow these control 
measures:
• Always wear appropriate laser safety eye wear for protection 

against the specific wavelengths and laser energy being generated.
• Never look directly into the laser light source or at scattered laser light 

from any reflective surface, even when wearing laser safety eye 
wear.

• Laser beams can easily cause flesh burns or ignite clothing.
• Avoid wearing watches, jewelry, or other objects that may reflect or 

scatter the laser beam.
• Terminate the laser beam with a light-absorbing material, and use 

energy-absorbing targets for beam blocking.

Safety Precautions for Cameras
For LaserCams equipped with a Low-Distortion Face Plate (LDFP), 
additional precautions must be taken.
Some models of cameras have been modified by Coherent to remove the 
protective window attached to the sensor array and replace it with a 
Low-Distortion Face Plate (LDFP).
• LaserCam HR II - 1/2” USB Camera System (P/N 1282868)
• LaserCam HR II - 2/3” USB Camera System (P/N 1282870)
• LaserCam-HR II UV Camera System (P/N 1360550)
27
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The LDFP filter glass offers protection for the sensor, eliminates 
unwanted background light, and provides attenuation of the laser beam.
This modification allows for proper imaging of the laser beam, but leaves 
the sensor susceptible to damage. If the LDFP is removed from the 
camera, special precautions (described next) must be taken to avoid 
sensor damage.

IMPORTANT!
If the Low-Distortion Face Plate (LDFP) is 
removed, the Warranty is void.

Dust
If low-intensity spots or small circles are noticed in the camera video, as 
shown in this example, then dust may be present.  

Dust can cause distortion in the form of small circles if present on the 
LDFP filter glass, or can cause low-intensity spots if present on the 
sensor array. 
Observe the defects with a flashlight illuminating the camera. If the defect 
moves when the flashlight angle is changed, then the dust is on the 
LDFP; otherwise, it is caused by dust on the array.
28
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To correct this situation, use clean air at low-pressure (or methanol and 
lens tissue) to clean the LDFP filter glass. Use only low-pressure micro-
filtered clean air to blow dust off the sensor. 
Take all necessary precautions to insure that nothing makes any contact 
with the sensor surface.

Fringes
If the LDFP filter glass is installed in the camera, then fringes may appear 
in the video as shown here: 

The fringe pattern is due to a second reflection off the sensor and the 
LDFP superimposing back onto the original beam image.
To correct this situation, rotate the LDFP housing until the fringes are no 
longer present. Slightly turning the camera with respect to the laser beam 
may also reduce this effect.

CAUTION!
Use small, careful movements when rotating any 
devices to avoid laser back reflection!
29
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Laser Power Input
Depending on the LaserCam HR camera model, saturation occurs at 
various power levels and wavelengths. See the User Manual for the 
specific camera to read information about saturation levels and damage 
thresholds at various wavelengths.

China RoHS Label
The China RoHS label is as follows for LaserCam-HR systems:  

 
Part Name 

            Hazardous Substances  
 

(Pb) 
 

(Hg) 
 

(Cd) 
 

(Cr(VI)) 
 

(PBB) 
 

(PBDE) 

Cable Assembly X O O O O O 

SJ/T 11364  
O: GB/T 26572  
X: GB/T 26572  
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SERVICE AND SUPPORT
This section provides information about:
• How to contact Product Support
• How to obtain service
• Product shipping instructions

Contact Product Support
Coherent provides telephone and web-based technical assistance as a 
service to its customers and assumes no liability thereby for any injury or 
damage that may occur contemporaneous with such services.
For general Technical Support, contact your local Coherent Service 
Representative as described on the following page, or contact Coherent 
as follows:
• By phone: 1-(408)-764-4557 or 1-(800)-367-7890
• By e-mail: Customer.Support@Coherent.com
• To view a list of contact names, telephone numbers, and addresses 

worldwide, visit our website: www.Coherent.com

IMPORTANT!
Under no circumstances do these support services 
affect the terms of any warranty agreement between 
Coherent and the buyer. Operation of any Coherent 
laser with any of its interlocks (or safety features) 
defeated is always at the operator's own risk. 

For information about sensor products, go to:
https://www.coherent.com/laser-power-energy-measurement 
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Please be prepared to provide the following information:
• Model or part number of your unit
• Serial number of your unit
• A description of the problem
• Any corrective steps you may have attempted
For answers to frequently asked questions, go to this link, scroll down 
and click FAQ, then select “Ask a Question or Read the Answers”:
https://www.coherent.com/laser-power-energy-measurement/laser-
measurement-help-center

LSM Support in the USA and North America
If you are shipping products from within the United States or North 
America, contact LMC Technical Support directly, as follows:
• By phone: North America (800) 343-4912 or (408) 767-4042
• By e-mail: LSM.service@coherent.com
Telephone coverage is available Monday through Friday (except during 
U.S. holidays). Inquiries received outside normal office hours are tracked 
by our automatic answering system and promptly returned the next 
business day.

International LMC Support
If you are located in Europe, contact LMC Technical Support directly, as 
follows:
• Germany: +49–6071–968–0
• Japan: +813–5635–8680
32
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Obtaining Service
To obtain service under this warranty, Customer must notify the Company 
of the defect before the expiration of the warranty period and make 
suitable arrangements for the performance of service.
The Company shall, in its sole discretion, determine whether to perform 
warranty service at the Customer's facility, at the Company's facility, or at 
an authorized repair station.
If Customer is directed by the Company to ship the product to the 
Company or a repair station, 
Customer shall:
• Package the product (to protect from damage during shipping) as 

instructed in “Product Shipping Instructions” next.
• Ship it to the address specified by the Company, with shipping 

prepaid. back to Coherent in conjunction with recalibration and 
recertification.

• Coherent shall pay the cost of shipping the Product back to the 
Customer in conjunction with product failures within the first twelve 
(12) months of time of sale or during an extended 12-month 
warranty period.

Product Shipping Instructions
You must include a Returned Material Authorization number (RMA) 
assigned by the Company on the outside of all shipping packages and 
containers. Items returned without an RMA number are subject to return 
to the sender.
33
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To prepare a product for shipping to Coherent:

1. Contact Coherent Customer Service (see “Contact Product 
Support” in the next section) for a Return Material Authorization 
number.

2. Attach a tag to the product that includes the name and address of 
the owner, the person to contact, the serial number, and the RMA 
number you received from Coherent Customer Service. Pack this 
tag inside the box.

3. Wrap the product with polyethylene sheeting or equivalent material.
4. Using the original shipping and packaging materials, pack the 

product.
5. Seal the shipping carton with shipping tape or an industrial stapler.
6. Add the RMA number you received from Coherent Customer 

Service to the shipping label on the outside of the box.
Ship the product to the following address:
Coherent, Inc.
Laser Measurement and Control, Attn: RMA #_________
27650 SW 95th Avenue
Wilsonville, OR 97070
USA
34
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